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Upon completion of this lesson, you should be able to:

Background
B Understand the settings on the Control Panel. Control Panel
B Apply a predefined theme to the desktop. Desktop shortcuts
B Change the Windows desktop background. Desktop theme
m Customize the icons on the desktop. Internet Explorer
B Clean up your desktop. by Gempuiier
. . . My Documents
B Explain what a shortcut is and how it is used.
My Network Places
B Create and delete shortcuts.
Shortcut
B Assign a shortcut key to a shortcut. Wizard
[ |

Add a program to the Quick Launch bar.

Estimated Time: 1 hour

Windows programs run on the desktop, and objects are placed on the desktop. When you
install Windows XP, the original desktop you see may not be the exact desktop you want, but
you can customize it to suit your personal tastes. You can also customize the taskbar and Start
menu. In addition, you will learn how to use the Control Panel to adjust settings for hardware,
find system information, schedule routine maintenance, and change user account information.
Another way to customize your desktop environment is to add shortcuts. If you use particular
programs or documents frequently, you will learn how to create shortcuts for them so you can
access them quickly and easily.

The Control Panel

1-3.3.1
1-3.3.2
1-3.3.4
1-3.3.5

ou can open the Control Panel, which you will use to change settings on your computer
and customize the display, by selecting it on the Start menu. Notice that the Control Panel win-
dow, shown in Figure 3-1, has two panes like the Help Viewer and other windows we have seen.
The left pane includes a list of tasks you can choose quickly, and other places you can look for
information about the Control Panel and Windows. The right pane has nine categories you can

49


http://www.a-pdf.com/?product-split-demo

M1L8 C5338 33912_M1L8 C5338 33912 27/04/2010 09:19 Page 138 4@i

Module 1 Computing Fundamentals

pick to change settings and display options. Following are the categories and what you can do
with each of them:

B Appearance and Themes: Change the background, screen saver, or desktop items; customize
the Start menu and taskbar; apply a theme to your display; change the screen display resolu-
tion or colors.

B Network and Internet Connections: Create a small office or home network; change net-
work, Internet, and phone settings.

B Add or Remove Programs: Install, change, or remove software and Windows components;
see a list of installed software; control access to certain programs.

B Sounds, Speech, and Audio Devices: Change speaker volume and other settings for audio
and speech devices; change the sound scheme or individual sounds made by the computer.

B Performance and Maintenance: Enable energy-saving features; compress the data on your
hard disk drive; schedule routine maintenance tasks, such as disk cleanup and antivirus
checking; find system information.

B Printers and Other Hardware: Change settings for printers, keyboard, mouse, game con-
trollers, modems, scanners, and cameras; identify the hardware devices on your computer
and if they are running properly.

User Accounts: Change user accounts and passwords; change a user’s e-mail profile.

Date, Time, Language, and Regional Options: Change the language your system uses or
the date, time, or time zone; change the way numbers, currency, dates, and times are for-
matted and displayed.

B Accessibility Options: Adjust hardware and operating system settings for users with vision,
hearing, and mobility disabilities.

FIGURE 3-1
The Control Panel in the default Windows XP Category view
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If you are working on a networked computer, you may not be allowed to change all the
Control Panel settings. The network administrator can restrict access to some settings to prevent
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unauthorized users from making changes that can affect other users in a network, such as creating
a new user account or altering regional or language settings. Some hardware settings that control
how peripherals (printers, modems, and so on) are allocated in a network may also be protected
so that changes made by one user will not affect the entire network.

S TEP-BY-STEP 3.1

1. Click the Start button, and then click Control Panel in the Start menu. @
2. Select the Performance and Maintenance category in the Pick a category area (the win-
dow’s right pane).
3. In the Performance and Maintenance window, find the
Pick a task section and click the See basic informa- m
tion about your computer link. If your Control Panel window is
set to Classic view instead of the
4. The System Properties dialog box opens. If the default Category view, double-
General tab is not open, click on it to open it. You will click the System icon to open the
see information about the version of Windows you are System Properties dialog box.

using under the System heading.

. Click OK to close the dialog box.

. Leave the Control Panel window open for the next Step-by-Step.

\f}j: Technology Timeline

your trip. To purchase items during your journey, you must convert your Michigan dol-
lars to Ohio marks, Kentucky pounds, Tennessee lira, and Georgia francs. It would be
inconvenient, and also expensive, because every time you converted the money, the
money changers would charge you a fee. This is what tourists traditionally experienced
when they traveled in Europe. They had to convert their money to another currency
every time they crossed a border. Imagine how difficult it would be to keep track of
transactions in financial reports with so many different currencies to convert and differ-
ent symbols to represent them.

was first introduced in electronic trading—business transactions completed without
cash. In January 2002, euro notes and coins started circulating. The changeover to a
single currency affects banks, businesses, and consumers. The euro symbol now
appears in banks, on financial statements, and on retail price tags. Technology has
kept up with the new era. Windows XP allows users to change the default currency for-
mat to euros and many applications provide full support for entering, displaying, and
printing the euro symbol and for working with values in euro currency.

FORMATTING FOR EUROS

Imagine driving from Michigan to Georgia and needing five different currencies for

In 1999, 11 European countries embraced one currency unit—the euro. The euro
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T& Changing Control Panel Settings

1-3.3.3
1-3.3.5

52

Y ou now know many of the settings that can be configured using the Control Panel. Let’s
look more closely at when you would want to change settings and how to do it.

The computer uses its internal clock to display the correct time, even correcting for Daylight
Savings Time, but you may need to change the clock for some reason. For example, if you have a
notebook computer and you travel from the west coast to the east coast for an extended stay, you
would want to change the time zone setting to correct the time displayed. You can even configure
your system to automatically synchronize the time with an Internet time server. Files and folders
are date- and time-stamped when you create them and modify them, so having the computer’s
clock set accurately can be important. Think about any change you make and consider the con-
sequences of the change before you alter a setting. For example, you want files to be date-
stamped correctly; therefore, if you set the wrong date or time, you will have inaccurate and
misleading information associated with files.

Other settings that you may want to change include the speaker volume control or how the
mouse or keyboard works. Sometimes small adjustments can make a computer much easier and more
efficient to use. If you are one of several users of one computer, remember to check with a supervisor
or other users before making changes. Only make changes if they are needed. It’s a good idea to make
a note of the original settings so that changes can be modified or reversed if necessary.

S TEP-BY-STEP 3.2

. Click the Back button in the toolbar to return to the Pick a category window. Select the Printers
and Other Hardware category in the Pick a category area.

2. In the Printers and Other Hardware window, click Mouse

in the or pick a Control Panel icon area of the window. m—

3. The Mouse Properties dialog box opens. You will see In Classic view, simply double-
| tabs with inf . b h includ click the Mouse icon to open
§evera tabs with in ormatlonq out the mouse, mc;u - the Mouse dialog box, and click
ing how the buttons are configured, how the pointer the Printers and Faxes icon to
appears, and how the “Fast Wheel” scrolls through a open the associated dialog box.

document. Click each tab to view the information.

4. Click OK or Cancel to close the dialog box without changing any settings.

5. You will be back in the Printers and Other Hardware window again. Click View installed printers or fax
printers in the Pick a task section to open the Printers and Faxes window. The available printers and
faxes appear in the right pane, and the left pane lists tasks under one or more heading.

6. Click Add a printer in the Printer Task pane. The Add Printer Wizard will open.

7. In the Add Printer Wizard, you can read information about installing a printer. Read the text and then
click the Next button.

8. Click the Next button in the new dialog box to have the Wizard search for a newly installed printer.
Since no printer has been installed, you will see a message that says no new printer was found. Click
the Cancel button to close the Add Printer Wizard.

9. Close the Printers and Faxes window and then close the Control Panel window.
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You can also change some settings by double-clicking the appropriate icon on the right side
of the taskbar. Different icons may appear on your taskbar depending on the way your taskbar
has been customized. For example, click the time display to open the Date and Time Properties
dialog box, and if you see an icon that looks like a bullhorn, you can click it to open the Volume
Control dialog box and then adjust the speaker volume. Other icons may open control network
connections, printers, and other hardware, depending on what is installed on your computer.

S TEP-BY-STEP 3.3

1. Double-click the time display at the right on the taskbar to open the Date and Time Properties dialog
box, as shown in Figure 3-2.

FIGURE 3-2
Date and Time Properties dialog box
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2. Click on each of the three tabs, Date & Time, Time Zone, and Internet Time, to view the different
settings you can adjust.

3. Click the Date & Time tab and you will see the current month and year displayed in drop-down list
boxes, and the current date shaded or highlighted in a calendar grid on the left and a clock with a
second hand, and the current time displayed below it on the right.

4. Click on any other day in the calendar grid to select it. Notice the highlight has changed to the new date.

5. Click on the up arrow next to the time displayed in the text box on the right. Notice that the hours
number is highlighted, and it increases by an hour every time you click the arrow.

6. Click the Cancel button to close the dialog box without changing the settings.

7. Double-click the icon that looks like a bullhorn on the right side of the taskbar to open the Volume
Control dialog box. If this icon does not appear on your taskbar, skip steps 7 to 9.

8. In the Volume Control panel, use the slide control to make the volume just a little louder. You may
hear a sound when you adjust the setting.

9. Click the Close button to close the dialog box and save the change you made to the vol- @
ume setting.
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The Desktop

1-3.2.5

The first thing many people want to do when they start using Windows is to customize the
desktop to better suit how they work. For example, when Windows is first installed, the background
that covers your desktop is usually a picture of a green hill beneath a blue sky with white clouds.
(The name of this background is Bliss.) You can change the background to another picture or pat-
tern included with Windows, or you can add your own photograph or artwork. You can also select
a theme, which is a coordinated design that carries through all the elements of your desktop and
window, changing the colors of windows elements and highlighting and the way icons appear. A
screen saver may be included in a theme, or you can choose a different screen saver from Windows’
selection, or install a new screen saver program.

The desktop is your work area, and it’s easy to customize it just like you would a “real” desk,
by adding pictures, rearranging the items you use, making it easy to reach items you use fre-
quently, and even cleaning it up occasionally!

Customizing the Desktop

1-3.2.5

54

To change the way the desktop looks, you select the Appearance and Themes category in
the Control Panel and then click the Display icon to open the Display Properties dialog box.

FIGURE 3-3
Display Properties dialog box

Display Properties

Themes | Desktop | Screen Saver || Appearance | Settings |

Atheme is a background plus a set of sounds. icons, and other elements
to help you personalize your computer with one click.

Windows XP theme

Theme:

Windows XP Delete

Sample:

Example of
current theme
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As you see in Figure 3-3, the Display Properties dialog box has several tabs you can use to
change the appearance and the behavior of your desktop.
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B The Themes tab assigns a predefined set of icons, fonts, colors, sounds, and other window
elements to your desktop. Collectively these elements are called a desktop theme and give
the desktop a unified and distinctive look.

B The Desktop tab offers you a selection of pictures and graphics to use as a background on
your desktop. You can use one of the backgrounds that come with Windows or create one
of your own.

B The Screen Saver tab permits you to display static or moving graphics or a blank screen
when your system is idle.

B The Appearance tab controls the colors, fonts, and
sizes of various screen elements. You can change -
the appearance of these elements by selecting from m—
a set of predefined schemes or by creating your Right-clicking an empty area on

own scheme. your desktop (a place where
there is no folder or icon) and
clicking Properties on the short-

B The Settings tab allows you to change the resolu-

tion and the number of colors used by the display, cut menu will also open the
change the display type, and change other display Display Properties dialog box.
characteristics.

Selecting a Desktop Theme

Using the Themes tab, you can quickly modify your desktop background by selecting from a
set of predefined themes. If your computer has other users with their own user accounts, each
person can have a different theme.

To apply a new desktop theme, simply use the drop-down menu (beneath the word Theme)
to select one of the preconfigured themes (see Figure 3-4). The themes that are listed in your
Theme drop-down list may differ from the ones in Figure 3-4, but there will probably be several
choices in the list. When you click a theme, the new background will appear in the sample win-
dow in the center of the Display Properties dialog box. Click the Apply button; after a short wait,
the new theme will be set on the desktop.

FIGURE 3-4
Theme drop-down list
The default theme
. . Windows XP “
from previous versions To access themes

Mew Theme

of Windows ﬁ Currert Theme from the Internet

Windows Classic
More themes online. -
Browse...

Note

If your computer has an Internet
connection, you can access a
number of themes from the
Microsoft Web site by clicking
the More themes online option
on the drop-down list.
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S TEP-BY-STEP 3.4

1. Open the Control Panel and click the Appearance and

Themes link. m—

. \ . . . In Classic view, double-click the
2. Click the Display icon to open the Display Properties Display icon to open the Display

dialog box. Properties dialog box.

3. Select the Themes tab if it is not already selected.

4. On a sheet of paper, write the name of the desktop theme that is currently displayed in the Theme
list box.

5. Click the Theme drop-down list arrow, and then select Windows Classic if it is not already selected.
If it is already selected, select one of the other themes in the list.

6. Click the Apply button. Your theme will take effect after a short wait. The new desktop background
will appear in the Sample window in the Display Properties dialog box and you may see a change in
the Active Window displayed there also.

7. Click the Theme drop-down arrow, select the desktop theme that you wrote on your paper in Step 4,
and then click Apply. After a short wait, your desktop background will return to its former appear-
ance. Leave the Display Properties dialog box open for the next Step-by-Step.

Setting a Background Design

You can change a theme’s settings by making modifications to the other tabs available on the
Display Properties dialog box. For example, to change the background design, click the Desktop
tab and select one of the backgrounds. You can select from Windows’ preexisting backgrounds,
which are listed on the Background list box, or you can use other graphic files (for instance, from
a digital camera) as your background. By default, the background is set up to stretch across your
screen so it takes up the entire desktop area. You can center the background on the desktop or
tile it to fill the entire desktop. You select the option from the Position drop-down list box.

TEP-BY-STEP 3.5

1. Click the Desktop tab.

2. Select the Windows XP background:

a. Click the scroll down arrow in the Background list box until the Windows XP option appears, and
then select it.

b. Notice that a preview of your selection is displayed in the monitor graphic in the upper portion of
the Desktop tab.

¢. Verify that the Stretch option is displayed in the Position drop-down list box. The Windows XP back-
ground is a picture file, and by default, all picture files are stretched to cover the entire desktop.
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STEP-BY-STEP 3.5 Continued

3. Tile the background on the desktop:
a. Click the Tile option from the Position drop-down list.

b. Click the Apply button to reset the background. Notice that the background now fills the desktop
by repeating the graphic.

4. Click the Stretch option from the Position drop-down list, and then click the Apply button to reset the
background. Do not click the OK button. Leave the Display Properties dialog box open for the next
Step-by-Step.

Windows XP can display any picture or graphic file (usually files with a GIF, JPG, or BMP
extension) as a background. If you have picture files already stored on your computer, you can
simply browse and select the desired picture. You can also create your own graphic in the
Windows Paint program or some other graphics program and use it as a background.

S TEP-BY-STEP 3.6

1. Use the Flowers file in the Lesson 3 folder of the data files as a background:
a. Click the Browse button on the Desktop tab to open the Browse dialog box.
b. Select the drive and folder that contain your data files.

¢. Double-click the Lesson 3 folder, and then double-click the Flowers.jpg file. The Browse dialog box
closes, and the Display Properties dialog box reappears.

d. Verify that the Stretch option is selected from the Position drop-down list.
e. Click the Apply button to set the background.

2. Reset the background to Windows XP:
a. Scroll the Background list box, locate the Windows XP option, and click it.

b. Click the Apply button to set the background to Windows XP. Leave the Display Properties dialog
box (Desktop tab) open for the next Step-by-Step.

Customizing the Icons on Your Desktop m_

The Customize Desktop button toward the bot- You can download a picture or
tom of the Desktop tab provides a convenient way ci el froi dne Gl avd use
f to select which Windows program icons are 't as a background. Simply right-

or you to se program ; click the picture or image you
to appear on your desktop and to determine which want to use as a background
icons are used to represent those programs. Click and click Set As Background.
this button, and the Desktop Items dialog box opens
(see Figure 3-5). This dialog box contains a General

and a Web tab.
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FIGURE 3-5
The Desktop Items dialog box
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On the General tab (see Figure 3-5), you can select the desktop icons you want to appear by
checking one or more of the check boxes: My Documents, My Computer, My Network Places,
and Internet Explorer. These icons are discussed in detail below.

B My Documents is your personal folder where you can save the files you create and use. By
default, the My Documents folder contains two additional personal folders: My Pictures
and My Music.

B My Computer displays the contents of your computer. You can see the hardware devices,
resources, programs, and files that are stored on your computer. My Computer also pro-
vides information about different system resources, such as the size of the hard disk and
how much space is available on it. You can also use My Computer to format disks and to
run applications. (You may recall that My Computer is also accessible from the Start menu.)

B My Network Places lists all of the computers on your network, if you are connected to a
network. It permits you to browse through files on a networked computer.

B With Internet Explorer, you get a fast, personalized Web browser with communication
capabilities including sending and receiving e-mail, connecting to the Internet, designing
your own Web site, and teleconferencing.

Just below the Desktop icons, you will see a window showing the default icons that are used
for each of these items, as well as the Recycle Bin icon that is placed on your desktop by default.
If you want to use a different icon for any of these items, click the item you wish to change, click
the Change Icon button, and select a different icon from the choices provided. If you change your
mind or don’t like your choice, just click the Restore Default button to return to the Windows
XP default icon settings.
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S TEP-BY-STEP 3.7

. Click the Customize Desktop button. The Desktop Items dialog box (Figure 3-5) is displayed.

2. Click the General tab to verify that it is in the foreground.

3. Display the My Documents and My Computer icons on your desktop:

a. Click the My Documents check box in the Desktop icons area. (This will place a check mark in the
check box.)

b. Click the My Computer check box.
c. Click the OK button. The Desktop Items dialog box will close.

4. Click the Apply button on the Display Properties dialog box to place the selected icons on your desk-
top. Do not click the OK button on the Display Properties dialog box.

5. Change the My Documents desktop icon:
a. Click the Customize Desktop button to display the Desktop ltems dialog box.
b. Click the My Documents icon in the display window, and then click the Change Icon button.

¢. Click the folder icon shown in Figure 3-6, and then click the OK button. Notice that the icon
changes in the display window.

FIGURE 3-6
Folder icon

O

d. Click the OK button on the Desktop Items dialog box, and then click the Apply button on the
Display Properties dialog box. Notice that the icon on your desktop has changed to your selection.

6. Remove the My Computer icon from your desktop:
a. Click the Customize Desktop button to display the Desktop Items dialog box.

b. Click the My Computer check box to deselect (uncheck) it, leave the My Documents check box
checked, and then click the OK button.

c. Click the Apply button on the Display Properties dialog box. Notice that the My Computer icon is
no longer displayed on the desktop.

d. Close the Display Properties dialog box and then close the Control Panel or the Appearance and
Themes window if necessary.

Customizing a Toolbar

The standard toolbar is the row of buttons below the menu bar on most windows. Other
toolbars appear if you select them in the Toolbars submenu of the View menu. You can easily
change the buttons that appear on any toolbar. For example, to change the toolbar in the My
Documents window, open My Documents from the desktop. Click on the View menu, and then
select the Toolbars option. (The right-pointing arrow tells you a submenu will open.) When you
select the Customize option on the Toolbars submenu, the Customize Toolbar dialog box
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appears. The dialog box has two list boxes: Available toolbar buttons and Current toolbar but-
tons, as shown in Figure 3-7. The Available toolbar options list box on the left lists the types of
buttons available to place on the toolbar. The Current toolbar buttons list box on the right lists
the buttons that already exist on the toolbar. To add buttons to the toolbar, select a button from
the list box on the left and then click the Add button. To remove buttons from the toolbar, select
a button from the right and click the Remove button.

You can change the order in which the buttons appear on the toolbar by selecting a button in
the Current toolbar buttons list box and clicking the Move Up button or the Move Down button
to change the button’s position in the list box.

FIGURE 3-7
The Commands tab of the Customize dialog box
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Cleaning Up Your Desktop

Windows XP provides a number of utility programs that help you perform a task quickly and
easily. Each of these programs is called a Wizard and performs a special function, such as the
Add Printer Wizard you encountered earlier in this lesson. For example, as you use work, you
will place icons on your desktop. Because these icons function as shortcuts to an application or a
document, they are often referred to as desktop shortcuts. (You will learn how to create shortcuts
in the next section.) Windows XP contains a Desktop Cleanup Wizard that can check your desk-
top to see which desktop shortcuts you have not used during the previous 60 days; it then lets
you decide if you want to remove them. The desktop shortcuts you remove are moved to an
Unused Desktop Shortcuts folder from which you can recover them at any time.

Look again at the General tab on the Desktop Items dialog box shown in Figure 3-5. Notice
the Desktop cleanup area at the bottom of the sheet. In this area, you can set the Desktop
Cleanup Wizard to run automatically every 60 days, or you can run it any time by clicking the
Clean Desktop Now button.

Using Shortcuts

1-3.24

60

A shortcut functions as a pointer to an application or a document file, wherever the file is
located. When you double-click the shortcut icon, you’re opening the actual item to which the
shortcut is pointing. The shortcut is represented by an icon on your desktop. A shortcut icon is
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identified by a small arrow in its lower-left corner (see Figure 3-8). Shortcuts save time because
you don’t have to open and browse through several folders to find the file you need.

FIGURE 3-8
Shortcut icon

Identifies this as
a shortcut icon

You can create a shortcut by dragging a file to the desktop or by using the Create Shortcut
command on the File menu. Shortcut menus also appear when you right-click a file or folder on
your desktop, in the right pane of a folder window, or when you right-click an empty space on
the taskbar or desktop.

Creating a Shortcut Using Drag and Drop

If you can display an item in the My Computer window, you can create a shortcut for it by
dragging and dropping an item to the desktop with the right mouse button:

m Using the right mouse button, right-drag the item (file, program, folder, printer, computer)
from its current location to wherever you want the shortcut to appear.

Drop the item where you want it by releasing the mouse button.
A shortcut menu appears, giving you several options. Click Create Shortcuts Here.

The icon appears with the shortcut arrow and a default name.

You may want to change the shortcut’s default name to something different. To rename it,
right-click the shortcut’s icon to display the menu shown in Figure 3-9. Remember that you can
often open a task-specific shortcut menu by right-clicking an icon or text; in this case, the short-
cut menu options relate to creating shortcuts. Choose Rename, and key the new name in the
shortcut icon’s text box. You can use this shortcut menu for a number of tasks, such as deleting
a shortcut or changing its properties.

FIGURE 3-9
The shortcut menu for creating and managing shortcuts

Open

Print

Edit

Oipen With 3

Send To »

Cut
Copy

Create Shorkout

Delete

Rename

Properties m—
If you use the left mouse button
to drag a file from a folder on
the C drive to the desktop, you

will move the file and its icon to
the desktop.
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S TEP-BY-STEP 3.8

1. Open My Computer from the Start menu.

2. Locate the Assignments folder where you saved the file called Hobby created in Lesson 5.

3. Make sure that part of your desktop is visible, and using the right mouse button, drag the Hobby doc-
ument file icon to the desktop. Release the mouse button.

4. Select Create Shortcuts Here from the shortcut menu. The Hobby document shortcut appears on
your desktop.

5. Rename the shortcut:
a. Right-click the Shortcut to Hobby icon.
b. Select Rename from the shortcut menu. Notice that the icon’s name is now highlighted and has
a blinking insertion point.
¢. Key My Shortcut and press Enter to rename the icon.

6. Close the My Computer window.

Creating a Shortcut Using the File Menu

You can also create a shortcut by selecting the item for which you want (a file, program,
folder, printer, or computer) to create the shortcut in My Computer. Then from the File menu
select Create Shortcut. Resize the window so you can see the desktop. A shortcut icon for the
item appears as the last item in the My Computer window. Drag the new shortcut icon to the
desktop. Then you can rename it—as you have already learned.

Assigning a Shortcut Key to a Shortcut

A shortcut key is a keystroke combination that runs a program or opens the dialog box to
which it is linked. For example, if you assign the shortcut key Ctrl + Alt + N to your My
Shortcut, your new shortcut key will then open the Hobby document. You assign a shortcut key
in the shortcut’s Properties dialog box, which is accessible from the shortcut menu. You make the
assignment by pressing and holding the Ctrl key and then pressing the key you want to complete
the shortcut keystroke combination. When you press the Ctrl key, the combination Ctrl + Alt +
appears in the Properties dialog box. It ends with + because it is waiting for you to complete the
shortcut. Once you select OK, the shortcut keystroke assignment is made, and anytime you press
those keys, you will open the document.

You can activate a shortcut in two ways: Double-click the shortcut icon, or issue the shortcut
key combination.

S TEP-BY-STEP 3.9
1. Right-click the My Shortcut icon.

2. Select Properties from the shortcut menu. The My Shortcut Properties dialog box appears.
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STEP-BY-STEP 3.9 Continued

3. Make sure the Shortcut tab is displayed as shown in Figure 3-10.

FIGURE 3-10
Shortcut tab in the My Shortcut Properties dialog box

My Shortcut Properties

General -Shortcut |

Iy Shortout
[#]

Target bype:  Texk Document

Target location:  WINDOWS

Targek:

Start in: | CWINDOWS |

Shortcut key: |N0ne |

Run: |N0rma| window B |

Comment: | |

[ Find Target... ] [Change Icon... ] [ Advanced. .. ]

L (o4 ] [ Cancel Apply

4. Click in the Shortcut key text box.

Computer Conc Fq

5. Press and hold down Ctrl, press n, and then release If Windows is already using

Ctrl. The shortcut key Ctrl + Alt + N is displayed in the your selected keystroke combi-
Shortcut key text box. nation for another shortcut, it
will still allow you to make the
6. Click the OK button to save the shortcut keystroke assignment. When you enter

the keystroke combination,

cgmblnatlon, and close the My Shortcut Properties however, Windows will run the
dialog box. other shortcut. In this case,
just open the shortcut’s
7. Double-click the My Shortcut icon. Did the Hobby doc- Properties dialog box and
ument open? select a different keystroke

combination.
The letter name of your hard
disk may appear different from

I . that shown in the Target and
9. Issue the shortcut keystroke combination Ctrl + Alt + N: Siar i e bares i

a. Press and hold down Ctrl. Figure 3-10.
b. Press and hold down Alt.
c. Press n, and release all keys.

8. Close the Hobby document window.

10. The Hobby document once again opens. Close the document.
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Which method do you prefer—double-clicking the icon or issuing the shortcut key? You
probably found the first method simpler, but as you become more familiar with creating short-
cuts, you will see that shortcut keys are very useful when the shortcut is not in view or if you pre-
fer to keep your hands on the keyboard.

Deleting a Shortcut

Like most Windows elements, shortcuts can be deleted. There are several ways to delete a
shortcut:

B Select the shortcut, then press the Delete key.
m Right-click the shortcut, and then select Delete from the shortcut menu.
® Drag and drop the shortcut in the Recycle Bin.

If you double-click the icon or issue a shortcut, Windows displays a message box asking you to
confirm the deletion. Deleting a shortcut deletes only the shortcut, not the file to which the short-
cut points. If you drag the shortcut to the Recycle Bin, no confirmation message box appears; the
shortcut is simply moved to the Recycle Bin where it will remain until the Recycle Bin is emptied.

Adding a Shortcut to the Quick Launch Bar

With Windows, you have another choice for shortcuts: The Quick Launch bar on the taskbar
(see Figure 3-11). Always visible, the Quick Launch bar is great for those items you need to reach
fast. If you don’t see the Quick Launch bar, right-click in an empty part of the taskbar, point to
Toolbars, and then click Quick Launch.

FIGURE 3-11
Quick Launch bar

To add a button to the Quick Launch bar, drag a program, document, or desktop shortcut
icon to the Quick Launch bar. To remove a button from the Quick Launch bar, right-click the
shortcut and then select Delete from the shortcut menu.

SUMMARY

In this lesson, you learned:

B The Control Panel allows you to find information about system settings, change display
options, and customize your desktop.

You can modify your desktop using the Display dialog box tools and options.

You can select from Windows’ existing themes or choose a different background on the
Background tab.

m  Windows comes with a number of preexisting desktop themes that give your desktop a uni-
fied and distinctive look. A picture can be tiled to fill the whole screen, centered on the
screen, or stretched across the screen.
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You can use most any picture or graphic file as a background. For example, you might take
a photograph on a digital camera or download a graphic from the Web and then use it as a
desktop background.

The Desktop Cleanup Wizard is used to remove any unwanted or unused desktop shortcuts
from the desktop.

A shortcut functions as a pointer to a file—wherever it is located. Double-click the shortcut
icon to open the actual item to which the shortcut is pointing.

You create a shortcut by dragging and dropping or by using the Create Shortcut option on
the File menu. When you no longer need a shortcut, it can be deleted without impacting the
original instance.

You can add a shortcut key to a Windows shortcut. A shortcut key is a keystroke combina-
tion that runs a program—or in this case, runs the Windows shortcut to which it is linked.
Shortcut keys to Windows shortcuts always use Ctrl + Alt + and one additional character.

You can place a program, document, or desktop shortcut icon that you plan to use often on
the Quick Launch bar.

VOCABULARYRepiew

Define the following terms:

Background Internet Explorer My Network Places
Control Panel My Computer Shortcut
Desktop shortcuts My Documents Wizard

Desktop theme

REVlEWQuestions

TRUE/FALSE

Circle T if the statement is true or F if the statement is false.

T

T

F 1. The Background tab in the Display Properties dialog box lets you change the col-
ors, fonts, and sizes of various screen elements.

F 2. By default, your desktop’s background is a solid color.

F 3. Even though other users share your computer, you must all have the same theme
for your desktops.

F 4. Windows XP can display any picture or graphic file with a GIE, JPEG, or BMP
extension.

F 5. Right-clicking a shortcut icon displays the shortcut menu.
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MULTIPLE CHOICE
Circle the best response for each of the following statements.

1. You can create a shortcut by using the Create Shortcut commandonthe _ menu
in My Computer.
A. Insert
B. Help
C. View
D. File

2. A(n) __ isa keystroke combination that runs a program or opens the dialog box
to which it is linked.
A. icon
B. shortcut key
C. Ctrl key
D. Wizard

3. The ___ tab in the Display Properties dialog box that lets you assign a predefined
set of icons, fonts colors, sounds, and other window elements to your desktop.

Settings

Themes

Appearance

Desktop

SOm»

4. A ___ isa utility program provided by Windows that helps you perform a task
quickly and easily.
A. Quick Launch
B. Control Panel
C. Shortcut
D. Wizard

5. Aln) — isrepresented by a small arrow in the lower-left corner of its icon.
A. dialog box
B. screen saver
C. shortcut
D. desktop

PROJECTS

PROJECT 3-1

Before you begin, ask if your instructor wants to see the background you create in this project.
1. Open the Control Panel and click the Appearance and Themes link.

2. Click the Display icon to open the Display Properties dialog box. (If your Control Panel
appears in Classic view, double-click the Display icon to open the Display Properties dia-
log box.)
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3. Click the Themes tab if necessary, and write down the name of the desktop theme that is
currently displayed in the Theme list box.

4. Modify the theme:
A. Click the Desktop tab, select the Ascent Background, and then click the Apply button.
B. Click the Themes tab, click Save As, key Project 3-1 Theme in the File name textbox,
and then click Save.

5. Click the arrow in the Themes list box and verify that the Project 3-1 Theme is displayed in
the list.

6. Delete the Project 3-1 Theme:
A. Select Project 3-1 Theme from the Theme list box.
B. Click the Delete button.

PROJECT 3-2

1. Verify that the Quick Launch bar is displayed. If not:
A. Right-click a clear area on the taskbar, then select Toolbars from the shortcut menu.
B. Select the Quick Launch option.

2. Move the My Shortcut icon on your desktop to the beginning of the Quick Launch bar:
A. Right-drag the My Shortcut icon from the desktop to the Quick Launch bar.
B. Select the Move Here option from the menu.

3. Test the shortcut:
A. Click the My Shortcut icon on the Quick Launch bar to open the Hobby document.
B. Close the Hobby document.

4. Delete the shortcut from the Quick Launch bar:
A. Right-click the My Shortcut icon on the Quick Launch bar, and then click Delete on the
shortcut menu.
B. Click Yes in the message box to confirm the deletion.

5. Follow your instructor’s directions to log off or turn off your computer.

PROJECT 3-3

Shortcuts are handy tools, but too many shortcuts on the desktop can make it look cluttered
and confusing. List other advantages and disadvantages of using shortcuts, including the pros
and cons of assigning shortcut keys.

E TEAMWORK PROJECT

One of your coworkers is collecting informal inventories of all employees’ computer systems.
She has requested a list of the system resources and hardware devices on your computer. Working
with another student, create a table that includes your name, the system information, such as the
computer model, operating system, and registration information, and the hardware devices con-
nected to each of your computers. In a paragraph below the table, explain where you found the
information.
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